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such changes. 
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are liable or responsible to the purchaser or user for loss or damage caused, or alleged to 
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Learning Multiframe 

Welcome to Learning Multiframe. This introductory training manual will give 

new users to Multiframe a thorough understanding of the applicationôs 

architecture, main functions and give an idea of its capabilities. Experienced 

users will also find this manual useful to expand their understanding of concepts 

or simply as a refresher. 

 

This training manual is by no means an extensive guide to using Multiframe. If 

you need help or would like more information on certain topics, the manual 

should be consulted. The training manual consists of several short tutorials, each 

with their own concrete learning goal. Throughout the tutorials, the user will 

model a simple structure, apply some loads and perform a structural analysis. 

Each tutorial may have different related resources such as: 

1. Sample designs. Some sample designs have been provided along with 

the tutorials. These can be found in the c:\program 

files\Multiframe\Training Samples directory after you have installed the 

Learning Multiframe installer. For Vista this is 

C:\Users\Public\Documents\Multiframe\Multiframe##, where ## is the 

version number. 

 

2. Explanations of background theory. It is recommended to read these 

sections. 

3.  Videos. There are several short videos you can watch that illustrate 

the steps explained in the tutorial.  

a. [Web] You can click on this link for each video to view the 

video online; i.e. on the internet. This will open up the video in 

your Internet browser. You do need a reasonably fast internet 

connection for this. 

b. [Disk] Click on this link from your PDF document when you are 

running this training manual from your local computer. This will 

start up the video from your local hard drive. This is generally 

much faster than viewing the videos online, but it does require 

that you have installed the MFLearning installer available from 

the website. Links to ñ[Disk]ò only work from the PDF 

document and not from your internet browser. 

4. Links to the User Manual for background reading on concepts, or further 

explanation of dialogs and related commands. 

 

Tips on using this training material: 

 Take your time and read all instructions carefully  

 Read explanations,  try to understand the concepts explained  

 

If you are not familiar with the concepts of structural analysis using the matrix 

stiffness method, it will be necessary for you to review the structural analysis 

concepts outlined in Chapter Four of the Multiframe manual. If you are familiar 

with the analysis, you can proceed at your own pace. 

 

Start with reading Chapter 1 Multiframe Help. 
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Chapter 1 Multiframe Help 

Before you can start learning how to use the program, it is important that you 

learn what to do when you want more information on using particular commands 

or you need help with a particular feature. Every command in the Multiframe 

application is thoroughly documented in the User Manual. This section of the 

training manual describes how to open the manual and find what you are looking 

for. 

Opening the Manual 

You can access the manual from different locations: 

1. From the Windows Start Menu: Programs | Multiframe | Help 

2. From within the application in the Help menu 

3. From within the application by pressing the F1 function key.  

Note 

In this Training Manual, a vertical bar ó|ô will be used to separate 

menu titles, sub-menu titles and commands in specifying the 

location of a command from a menu. For example, Help | 

Multiframe Help indicates that Multiframe Help can be accessed 

from the Help Menu. 

 

Many commands can be accessed from toolbars and via keyboard 

shortcuts (specified in the menus); however in this manual, access 

to commands will be described through navigation of the menus.  

You will need Adobe PDF reader to open the manuals. 

Finding a Topic 

If you have opened the Multiframe User Manual PDF file, you can search for a 

key word or phrase by clicking on Search from the Edit menu, and following the 

instructions in the Search PDF pane. 

 

You can also use this toolbar button:  or Ctrl+Shft+F .  

Other Resources 

The manual is also available in online format from the Formation Design 

Systems Support Centre at www.formsys.com/support.  

 

The Support Centre also offers a Knowledgebase which includes Frequently 

Asked Questions and Tips and Tricks databases. 

 

Next we will have a brief look at starting Multiframe and opening and closing a 

design in Chapter 2 Starting Multiframe. 

http://www.adobe.com/
http://www.formsys.com/support
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Chapter 2 Starting Multiframe 

If you have not already done so,  

ü Install Multiframe by inserting the CD and running the Setup 

program, and follow the instructions on screen. 

ü Launch the Multiframe application on your computer from the 

start menu.  

You should see something like this:  

 

If you see something completely different:  

ü Close the application and start it again, this time while holding 

down the Shift key.  

This will bring up the following dialog:  

 

ü Clear all Multiframe Preferences 

Continue with Opening a Design.  
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Opening a Design 

Opening a Design ï Concepts 

A Multiframe file has a .mfd file extension and can be recognised by the  file 

icon. A Multiframe file has all the information for the structure, but the 

membersô sections are stored in the Multiframe section library. This sections 

library file, SectionsLibrary.slb, is stored in  

 C:\Program Files \Multiframe \ , or  

 C:\Users \Public \Documents \Multiframe \Multiframe## for Vista, where ## is 

the version number.  

 

 

+ 

 

 

= 

 

MultiframeFile.mfd  SectionsLibrary.slb  
Multiframe 

Structure 

 

Since the SectionLibrary.slb file can change from project to project it is 

recommended to save a copy of the SectionLibrary.slb file with your .mfd file in 

your project folder. This then allows you to re-open any project with the same 

sections from when you last opened the project. In a multi-user environment 

there are different ways of managing the SectionsLibrary, see the Multiframe 

manual section ñWorking with the Section Libraryò for more information.  

 

When you open a design after the sections library has been changed you will get 

the following warning message:  

 

In case you open a design with for example the wrong sections library file you 

will see this warning: 

 

As in most Microsoft Windows applications, you can open files in different 

ways. For example, you can open files by double clicking on them or by using a 

File | Open menu. Letôs have a look at the different ways you can open a file in 

Multiframe. 

http://www.formsys.com/extras/FDS/webhelp/multiframe/working_with_the_sections_library.htm#Working_with_the
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Opening a Design ï Procedures 

File | Open 

Probably one of the most conventional ways to open a file is by: 

ü Start the Multiframe application  

ü Click File | Open Design 

ü Navigate to the Multiframe program file directory. 

This is C:\Program Files\Multiframe, unless you have specified it differently. 

(C:\Users\Public\Documents\Multif rame\Multiframe## for Vista) 

This is where you find a range of sample designs for the different versions of 

Multiframe (2D, 3D, and 4D). 

ü Open the 2D Sample Frames folder 

 

ü Select the 2DPortal.mfd file and click Open. 

Opening a Design ï Procedures 

Double clicking on a file 

ü In Windows explorer, navigate to the 2D Sample Frames and 

double click on the 2DPortal file. 

ü This will start up a new Multiframe application and open the 

design. 

Opening a Design ï Procedures 

Drag and drop 

When you have the Windows explorer window open as well as the Multiframe 

application and both are visible, it is possible to drag and drop a file into the 

Multiframe window to open it. 

ü Start explorer and start Multiframe  

ü Have the explorer window visible as well as the Multiframe 

application. You can do this for example by maximising Multiframe 

and then selecting Windows Explorer using Alt+Tab or the 

Windows Taskbar. 

ü Select the 2DPortal file and drag it into the Multiframe 

application window.  

While you are doing this, you will see your mouse pointer change to:  
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Dragging and dropping a file from explorer into the Multiframe application window. 

ü When you release the left mouse button, the file is opened in 

Multiframe.  

Continue with Closing a Multiframe Design.  

Closing a Multiframe Design 

You can close a design from the File menu:  

ü File | Close Design 

In case there have been any changes to the model since you have last saved it, 

Multiframe will ask you whether you wish to save the design changes. 

 

 Selecting yes will save the changes and close the model.  

 Selecting no will not save your changes and close the design. You will lose 

all changes since the last save.  

 Selecting cancel will cancel the close design command and allow you to 

continue working.  

 

Next you will learn how Multiframeôs user interface has been designed as well as 

several tools to customise windows in Chapter 3 User Interface 
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Chapter 3 User Interface 

In this training manual it is assumed that the user has a reasonable familiarity 

with working in applications on any Microsoft Windows
®
 operating system. 

Some Multiframe specifics to the User Interface are described below. It is a good 

idea to read this section before you start modelling a structure, as it will give you 

a good understanding of the architecture of the application which helps you find 

commands faster and operate the program more efficiently. 

 

The User Interface can be defined as the aggregate of tools available that 

allow you to work with the application. Some of these tools can be used for 

viewing while others allow you to control or manipulate the object being viewed.  

 

The Multiframe User Interface can be divided up into three main groups: 

 Menus  

 Toolbars  

 Windows  

Menus 

Unlike some other CAD applications Multiframe does not have a command line. 

This has the advantage that you donôt have to memorise different commands and 

everything can be done using the commands in the menus. 

 

To enable faster access to the menu commands Multiframe has two other 

options: 

1. Toolbars. The most common commands can also be accessed through 

toolbars.  

2. Additionally, Multiframe has several object based right click commands. 

This means that after selecting an object and using the right mouse 

button, Multiframe displays the most commonly used commands on the 

selected object. For example, when you select a node in the structure and 

right click on it:  

 

Right click menu on a node 

These are just other (usually more efficient) ways to get to a corresponding menu 

command. 

 

The menus and toolbars in Multiframe operate in the same way as most 

Microsoft applications and will not be explained any further. At this stage it is 

not required to know all the menu commands as we will cover most of them as 

we go along in this training manual, but for the interested reader the function of 

each Menu command is explained in detail in the Menus section of the Reference 

Chapter of the Multiframe manual. 

http://www.formsys.com/extras/FDS/webhelp/multiframe/menus.htm#Menus
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A brief overview of the menus is worth studying: 

 

Menu Description 

File  Working with files and libraries 

Edit Copying and pasting data and working in tables 

View Lets you set how you want something displayed. Often 

confused with the Display menu. 

Select Powerful commands to automatically select parts of the 

structure. 

Geometry Functions for creating and editing the geometry of a frame, eg. 

move, rotate etc. 

Group Organise the members in the structural model into groups or 

assemblies. 

Frame Functions for editing the properties of a frame and its 

components, eg. section type, restraint etc. 

Load Creating and editing loads 

Display Select what you want to display 

Case Creating and editing Loadcases 

Analyse Analyse options 

Time Time options. Only available in 4D 

Design Design checks. Only available if Steel Designer code has been 

purchased. 

Data All commands to do with calculations & producing data 

Window Different window display options 

Help Accessing different Help resources 

Toolbars 

The toolbars contain toolbar buttons that activate menu commands. Only the 

most commonly used menu commands are on the default toolbars. Dependent on 

the purpose of the toolbar, the toolbar is docked in: 

1. Multiframe window; general commands such as undo, redo etc. 

2. Specific view windows; commands that only apply when working in that 

window, eg ñDraw frameò in the Frame window. 

 

Toolbars from a specific view window can not be docked in the main application 

and visa versa. 

 

It is not required to read this section, but for the interested user, a detailed 

description of each toolbar can be found in the Toolbars section of the 

Multiframe Reference chapter. 

Windows 

Multiframe contains 7 windows and each window serves a specific purpose. 

These windows can be divided up in two groups: 

1. View windows 

2. Data windows (tables, graphs and reports) 

 

http://www.formsys.com/extras/FDS/webhelp/multiframe/toolbars.htm#Toolbars
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View windows 

The three view windows are: 

Frame Defining structural geometry, assigning sections and restraints 

Loads Defining load conditions to be applied to the structure 

Plot After the structure and loads have been defined and an 

analysis has been performed, analysis results can be viewed in 

the Plot window. 

 

Each of these view windows allows you to view your structure from 

different directions. See the section on View Directions in the Multiframe 

manual. Especially because structures can become quite complex there are 

a range of other tools that help you for example clip, mask, rotate and 

select parts of your structure in the View windows. A big part of learning 

Multiframe is learning to work in the view windows efficiently. You will 

learn this in the tutorials later on in this training manual. 

Data windows 

Data Viewing and editing structural data (eg sections and 

restraints) as well as loads 

Result Viewing analysis results such as deflection values, stresses 

and reaction forces.  

CalcSheet This window is used for preparing and evaluating design 

calculations that use the results of the analysis as a basis for 

design checks. 

Report This window is used for viewing analysis details or design 

calculations when Steel Design is also installed. 

 

In the next section you will learn about different window layouts that you can 

use while working in Multiframe in the section Working with Windows in 

Multiframe. 

Working with Windows in Multiframe 

All windows can be maximised, closed or minimized in Multiframe. This gives 

you a range of options to customise the user interface to your personal 

preferences. The window menu has a few commands that can help you organise 

windows. 

http://www.formsys.com/extras/FDS/webhelp/multiframe/view_directions.htm#View_Directions
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Multiframe Windows Layout ï Concepts 

 
A combination of closed or minimised data windows and cascaded view windows  

in the Multiframe application window 

 

The three view windows tiled vertical.  
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Only the loads window maximised. 

Generally you will find that you will need maximum window size when you are 

for example defining structure or loads. In that case it is easiest to maximize that 

particular window and then switch between the different windows if you need to. 

 

To avoid having to manually customise windows when you for example switch 

from working in ñmodelling modeò to working in ñresults modeò, Multiframe 

has so called pre-made ñWindows Layoutsò. These can be found in the Window 

menu: 

 Edit Layout  

 Result Layout  

 Calc Layout  

 Report Layout  

Multiframe Windows Layout ï Video 

 This video shows you the different Window layout options in Multiframe 

and how to switch between them.  

[Web] 

[Disk] 

Multiframe Windows Layout ï Procedures 

ü Select Edit Layout  

This brings up the Frame and Load view windows as well as the Data window 

for model input. Notice that the Data window has several tabs down the bottom. 

ü Select Result Layout 

You now see the Plot and Load view windows as well as the Result data 

window. Notice that the Results window has several tabs down the bottom. 

 

Next: Switching between Windows. 

http://www.formsys.com/support/learning-centre/learning-multiframe/learning-multiframe-videos/windows-layout#S4vM4Mf3AlIjT6NU_ocL-g
MFTrainingVideos/WindowsLayoutP.avi
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Switching between Windows 

Switching between windows ï Concepts 

A Window can be either in the background (passive/display only) or it can 

be the ñcurrent windowò. A background window is a passive window used for 

display only and you can not type or modify any of the objects in it. Only one 

window can be the current window or active window. Only in this active 

window objects can be modified (eg. change loads or data in a table). 

 

You may click within any window to make it the active window. If you have 

several windows open, you can recognise the active window by the brighter 

colour of the title bar. A window may also be brought to the top by selecting its 

name from the Windows menu. 

Switching between windows ï Procedures 

ü Start Multiframe while holding down the shift key 

ü Click yes to clear all saved Preferences 

 

ü Maximise the Frame window by clicking the  button in the top 

right corner of the window. 

 

This will maximise the Frame window inside the Multiframe application 

window: 
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Note: When a particular window is maximised, the programôs title bar reflects 

which window is being displayed:  

ü Now select Window | Load 

The Load window is now maximised and the Load window specific toolbars are 

visible.  

ü Now Click on the Restore window button in the top right of the 

Mult iframe application window: 

 

This restored the Loads window to its previous size and location. 

Tip:  

You can also switch between the design view windows by using the 

Window toolbar: . 

You now have enough background information to start modelling your first 

structure in Chapter 4 ..
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Chapter 4 Before Modelling.. 

To introduce you to the concepts and techniques you will use in Multiframe, this 

chapter will describe a simple frame analysis step by step. The frame you will 

analyse is shown below. You will analyse it for the two different loading 

conditions shown and for a superposition of the loads. 
 

25 

10 10 

10 

1 

5 

 

First, you will draw the frame to scale, one member at a time, inside the Frame 

window. Then, you will move on to defining loads and then finally analyse the 

structure. 

 

Start with Preparing Multiframe. 

Preparing Multiframe 

Preparing Multiframe ï Concepts 

Before you can start drawing, it is a good idea to first create a workspace. This 

can be compared to selecting a canvas or paper size before you start sketching a 

paper drawing. (The only difference being that the canvas size in Multiframe can 

be easily enlarged later). 

 

You should also consider setting up a Grid. This can be compared to selecting 

either blank or grid paper. To make it easier for you to draw the frame, you can 

use Multiframe's Grid option to make drawing automatically align to a grid with 

regular spacing. 

Preparing Multiframe ï Video 

 View a short video that shows you how to setup a "workspace" in 

Multiframe including a grid.  

[Web] 

[Disk] 

Preparing Multiframe ï Procedures 

Setting up Canvas Size 

ü Start Multiframe and maximise the Frame window 

It is necessary to first set up the size of the drawing in the Frame window. 

ü Choose Sizeé from the View menu 

A dialog box will appear with fields in it specifying the maximum dimensions of 

the frame. Note that his tutorial will work regardless of whether you are using 

metric or other units. 

http://www.formsys.com/support/learning-centre/learning-multiframe/learning-multiframe-videos/preparing-multiframe#9dlDgPOlAv15vMucmDqcGQ
MFTrainingVideos/MFPreparingMultiframeP.avi
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ü Type 20 for the maximum x coordinate and then press the Tab 

key to move to the second field 

ü Fill out the rest of the dialog as in the image above 

ü Click the OK button when you have finished entering the values 

If you make a mistake entering the numbers, you can use the backspace or delete 

key to delete the character just to the left of the blinking cursor and you can use 

the Tab key to move from one field to the next. 

Preparing Multiframe ï Procedures 

Setting up a Grid 

To make it easier for you to draw the frame, you can use Multiframe's Grid 

option to make drawing automatically align to a grid with regular spacing. 

ü Choose Gridé from the View menu 

A dialog box will appear with values for the x (horizontal), y (vertical) and z 

spacing of the grid. 

  

Grid dialogs for Multiframe 3D and Multiframe 2D 

ü Type 1 for the x spacing, use the Tab key to move to the other 

fields and continue to fill out the dialog as shows above 

ü Tick the Snap checkbox to make subsequent drawing align with 

the grid and click OK. 

This will also turn on the Visible checkbox to make the grid visible in the Frame 

window. Now move the pointer inside the Frame window and notice that as you 

move the mouse, the coordinates of the pointer are shown at the bottom left hand 

corner of the window.  The coordinates will automatically align to the nearest 

point on the grid. 

 

You can now begin to draw the structure to scale in the Frame window. Users of 

Multiframe 2D, 3D and 4D you should continue with Chapter 5 Tutorial 2D.
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Chapter 5 Tutorial 2D 

Multiframe in 2D ï Concepts 

Multiframe is available in different versions dependent on the number of 

dimensions required: 

 2D; modelling in X & Y coordinates. The model can be viewed in 3D  

 3D; modelling in X, Y & Z coordinates  

 4D; modelling in X,Y & Z coordinates as well as the  ability to do model 

analysis and apply time varying loads; for example a oscillating Sin 

function or an Earthquake simulation.  

 

If you are using Multiframe 2D, you will notice a number of differences from the 

illustrations in this manual. In general, fields in dialogs associated with 3D 

modelling will not be visible in the 2D version of the program. All of the 

commands in 2D work the same as the commands in 3D, the only difference is 

that items that relate only to dimensions, deflections or forces in the z direction 

will be omitted from the 2D version. 

Multiframe in 2D ï Video 

 This video shows you how to model a simple 2D structure in Multiframe. 

You will learn how the cursor snaps onto grid points and joints, how to assign a 

section to a member and how to display the structure in 3D including rendering. 

[Web] 

[Disk] 

Multiframe in 2D ï Procedures 

Start with: Drawing the Frame. 

Drawing the Frame 

To draw the first member in the frame 

ü Select Add Member from the Geometry menu 

ü Or choose the Add member icon from the Member toolbar 

 

A cross hair will appear in the Frame window. 

ü Move the cross hair to the location of the first joint 

Move the cross hair towards the axes at the bottom left hand part of the window 

until the coordinates read x=0.000, y=0.000. 

ü Press the mouse button and hold it down 

http://www.formsys.com/support/learning-centre/learning-multiframe/learning-multiframe-videos/modelling-a-simple-2d-structure#cdh80bVu0HqmovIvaKcGHA
MFTrainingVideos/MF2DStructureP.avi
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ü Drag the crosshair to the position of the second joint 

Move the crosshair up and to the right. Notice that as you move the crosshair, the 

member is continually re-drawn to show its current position. The coordinates, 

length and slope of the member are also shown. Move the crosshair until the 

coordinates read x=10.000, y=10.000. 

ü Release the mouse button 

Note that you may choose to click on the first joint and click on the second joint 

to draw a member instead of dragging the mouse. 

 

When you click or release the button the member is drawn in its final position. 

Notice also that two small black squares are drawn showing the position of the 

joints marking the ends of the member. 

 

You can now draw the second member, which runs horizontally across from the 

top right hand end of the first. 

ü Choose Add Member from the Geometry menu 

ü Move the cross hair to the top right hand joint of the member you 

have drawn 

ü Click on the joint and drag to draw the member 

ü Release the mouse button when the coordinates read x=20.000, 

y=10.000 



Learning Multiframe 

Page 25 25 

 

When you add a member by clicking on or very close to an existing joint, 

Multiframe will create a connection between the existing joint and the new 

member. In this case, Multiframe has connected the two members together at the 

common joint. 

 

If you make a mistake with the position of any joints, you can drag them to a 

new position using the mouse or double click on them to enter a new location. 

 

This completes the setup of the geometry of the frame. You can now move on to 

applying the restraints and section types needed for the structure. 

ü Save your work as MF2DStructure.mfd. See the next section on 

Saving Your Work. 

Saving Your Work 

If you are using the Multiframe demo, you will not be able to save.  Demo users 

may wish to skip to the Summary to continue reading. 

 

Now that you have created and analysed a structure, it is probably a good idea to 

save the work you have done. 

ü Choose Save As from the File menu 

 

Project Properties 

If you are saving for the first time, a dialog box will appear allowing you to save 

project and designer information with your file. 
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ü Type in the properties of the project.  

ü Select the Designer tab.  

 

ü Type in the details of the designer.  

ü Click on the OK button 

This dialog also contains two additional pages that display properties of the file 

and statistics about the frame. You can change these properties at any time using 

the Properties command from the File menu. 

 

Next: Selecting a Joint 

Selecting a Joint 

In order to set the restraints and section properties for the structure, you first 

need to select the members and/or joints that you want to work with.  

 

You will find it helpful to turn off the grid now that you have finished drawing 

the structure. 
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ü Choose Gridé from the View menu 

ü Click on the Snap radio button to turn off the grid 

ü Click OK  

The grid display and alignment features in the Frame window are now turned 

off. To select the first joint 

ü Point to the bottom left hand joint of the frame and click 

 

Notice that a larger square appears at the joint. This indicates that this joint is 

selected.  

 

Next: Restraining a Joint 

Restraining a Joint 

Joints that cannot move freely in a structure must be restrained in some way in 

the Multiframe model. This restraint may be horizontal, vertical, a restraint 

against rotation or a combination of these restraints. 

 

To apply the pinned restraint to the joint you have selected 

ü Choose Joint Restraint from the Frame menu 

A dialog box will appear with a number of icons in it. Note that this dialog can 

also be accessed using right clicking on the joint. 

 

ü Click on the pinned restraint icon 

ü Click OK  

Notice that the pinned restraint icon is now displayed at the joint that was 

selected. A pinned restraint prevents the joint from moving horizontally or 

vertically but allows it to rotate freely. You could also apply this restraint by 

clicking on the Pinned Restraint icon in the Joint toolbar. 
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Next select the top right hand joint of the frame by clicking on it. 

ü Click on the top right hand joint on the frame 

ü Click on the Fixed Restraint icon in the Joint toolbar 

 

A fixed joint cannot rotate or move vertically or horizontally. 

 

Next: Section Properties 

Section Properties 

In order to compute deflections in the structure it is necessary to know the 

material properties and dimensions of the sections used in the structure. 

Multiframe has a built-in table of the most commonly used structural sections 

from which you can select the desired section type. Multiframe also allows you 

to add your own sections to the library, see Adding a Standard Section and 

Adding a Custom Section in the Multiframe manual. 

 

Next: Selecting a Member 

Selecting a Member 

In order to specify the section properties for the members in the frame, it is 

necessary to select each of the members in turn.    

 

To select the sloping member 

ü Point to the sloping member and click on it 

The member will be drawn with a bold line indicating that it is selected. 

 

ü Choose Section Type from the Frame menu 

Note that you have the option of clicking the right mouse button and choose 

Section Type from the short cut menu. 

 

A dialog box will appear with a list of groups and sections. 

http://www.formsys.com/extras/FDS/webhelp/multiframe/adding_a_standard_section.htm#Adding_a_Standard_Section
http://www.formsys.com/extras/FDS/webhelp/multiframe/adding_a_custom_section.htm#Adding_a_Custom_Section
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ü Click on a name in the list of section groups (eg UB) 

This will display, in the list on the right, the list of sections stored in this group. 

ü Use the scroll bar to scroll down the list of sections until your 

desired section is visible (eg until the 310UB40.4) 

ü Click on this name to select it 

ü Click on the OK button to confirm your choice 

Since the horizontal member uses a custom section that is not stored in the 

Sections Library, it is necessary to add the section to a custom group in the 

library. 

 

Next: Adding a Custom Section. 

Adding a Custom Section 

To add the custom section to the library 

ü Choose Add Standard Sectioné from the Sections submenu 

under the Edit menu 

A dialog box will appear that contains a list of groups and a table of section 

properties. 

 

At the top of the dialog, a name for the section can be entered. 










































































